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Abstract- CNC machines are one proof of the rapid development of technology that can help produce 

quality products. The use of lasers on CNC machines can produce optimal engraving. The purpose of this 
final project is to design a laser CNC machine with an Aruduino Uno controller. CNC laser engraver 
machine is a machine that is controlled using a computer to perform movements that can be used to engrave 
certain patterns or images automatically. A limit switch module is added to prevent damage due to 
movement errors. The research method in this final project is an experimental method in the form of 
engraving testing on MDF boards with a thickness of 6 mm. Testing has been successfully with the 
conclusion that a feedrate of 500 mm/min and 40% laser power can be used as an ideal parameter standard 
on MDF board workpieces with a thickness of 6 mm. Based on the tests that have been carried out, the 

influence of parameters greatly affects the final result. 

Kata kunci: 

CNC Laser 

Parameter Permesinan 

Papan MDF 
 

Intisari- Mesin CNC (Computer Numerical Control) adalah salah satu bukti dari pesatnya perkembangan 
teknologi yang dapat membantu menghasilkan produk berkualitas. Penggunaan laser pada mesin CNC dapat 
menghasilkan pengukiran yang optimal. Tujuan tugas akhir ini membuat Rancang bangun mesin CNC laser 

dengan kontroler Aruduino Uno. Mesin CNC laser engraver adalah mesin yang dikendalikan menggunakan 
komputer untuk melakukan pergerakan yang dapat digunakan untuk mengukir pola atau gambar tertentu 
secara otomatis. Modul limit switch ditambahkan untuk mencegah kerusakan akibat kesahalan pergerakan. 
Metode penelitian dalam tugas akhir ini adalah metode eksperimen berupa pengujian pengukiran pada papan 
MDF dengan ketebalan 6 mm. Pengujian telah berhasil dilakukan dengan kesimpulan feedrate 500 mm/min 
dan daya laser 40% dapat dijadikan standar parameter yang ideal pada benda kerja papan MDF dengan 
ketebalan 6 mm. Berdasarkan pengujian yang telah dilakukan, pengaruh parameter sangat berpengaruh 
terhadap hasil akhir. 

1. Pendahuluan 

Berkembangnya zaman seiring dengan ilmu pengetahuan dan 

teknologi. Perkembangan teknologi ini dapat kita lihat jelas khususnya 

di perindustrian Indonesia. Pekerjaan yang pada awalnya menggunakan 

tenaga manusia, kini beralih menggunakan mesin dan pekerjanya 

sebagai operator. Salah satu tujuannya adalah menciptakan produk 

berkualitas tinggi, mengurangi waktu bahkan biaya produksi. Maka 

diperlukan mesin CNC yang bersifat otomatis sebagai peralatan yang 

mendukung kinerja di industri modern. 

Inovasi pada mesin CNC (Computer Numerical Control) sangat 

berpengaruh dalam bidang manufaktur dan industri. CNC adalah suatu 

sistem yang dasarnya mengubah bahasa program G-code menjadi 

gerakan-gerakan sumbu pada mesin. Singkatnya, sistem pada mesin 

CNC terdapat komputer yang berfungsi mengubah G-code ke bahasa 

mesin yg kemudian diproses lalu dikirim kepada driver motor dalam 

bentuk sinyal, baik sinyal analog maupun digital. Dalam hal ini, aplikasi 
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LaserGRBL digunakan karena kemampuannya dalam mengubah vector 

gambar ke dalam G-code dan mengirimnya ke Arduino Uno yang 

selanjutnya menerjemahkannya satu-persatu agar dapat mengontrol 

motor stepper dan laser. Untuk produksi massal, penggunaan mesin 

CNC lebih unggul dikarenakan hasil yang lebih tepat, lebih teliti dan 

lebih fleksibel dibandingkan dengan mesin konvensional. Mesin CNC 

memungkinkan pembuatan produk dengan presisi tinggi. 

Mesin CNC mampu melakukan berbagai proses seperti pemotongan, 

pengeboran, dan pengukiran dengan akurasi yang sulit dicapai oleh 

metode manual. Salah satu jenis mesin CNC yang semakin populer 

adalah mesin CNC laser, yang menggunakan sinar laser untuk mengukir 

material non-logam. Mesin ini dikenal dengan mesin CNC engraver. 

Rancang Bangun Mesin Laser Engraving 2-D Berbasis 

Mikrokontroler Arduino Uno, cara kerja mesin CNC engraving sama 

dengan mesin CNC pada umumnya. Sebagai alat produksi dan 

menggunakan perintah G-code. Pengujiannya terbatas pada benda kerja 

kayu dan logam yang dilapisi cat anodize. Pada pengujiannya didapatkan 

hasil bahwa mesin dapat bekerja sebagaimana mestinya tanpa ada 

permasalahan, mesin dapat membuat gambar pada benda kerja sesuai 

dengan input yang diberikan pada antarmuka [1]. 

Penggunaan mesin CNC sudah banyak digunakan industri besar, 

namun pada lingkup UMKM masih melakukan produksi dengan cara 

manual. Disebutkan bahwa, souvenir yang menjadi ciri khas suatu 

daerah proses produksinya masih manual yaitu menggunakan teknik 

sablon. Oleh karena itu, diperlukan pengembangan inovasi yang dapat 

digunakan dalam proses produksi khususnya pada pelaku usaha 

menengah kebawah. Mesin CNC laser engraver dapat menjadi solusi 

yang tepat dari segi biaya pembuatan yang terjangkau dan hasil yang 

lebih berkualitas [2][3]. 

Penggunaan mesin CNC sebagai media pembelajaran praktek di 

sekolah baik di tingkat SMK hingga perguruan tinggi. Pembelajaran 

praktik CNC dapat membantu keterampilan peserta didik secara 

langsung. Namun kenyataannya, mesin CNC masih jarang ditemui 

dalam dunia pendidikan dikarenakan harganya yang mahal dan 

membutuhkan maintenance yang lebih [4]. 

Dalam industri furnitur dan kreatif tradisional, penggunaan kayu 

solid menjadi pilihan dalam pengukiran karena ketahanan dan keindahan 

serat alaminya. Kayu solid memberikan tampilan yang khas serta 

ketahanan terhadap beban dan kerusakan. Namun papan MDF atau 

Medium Density Fiberboard yang memiliki permukaan halus tanpa serat 

kini lebih sering digunakan oleh pengrajin untuk pengukiran 

dikarenakan lebih mudah untuk diukir dengan detail yang rumit [5]. 

Papan MDF dapat digunakan di berbagai aplikasi termasuk pembuatan 

furnitur hingga sebagai souvenir. Papan MDF terbuat dari serat kayu 

yang dipadatkan dengan resin, menghasilkan permukaan yang halus dan 

konsisten. Papan MDF (Medium Density Fibreboard) memiliki sejumlah 

ciri khas, di antaranya: kepadatan Sedang: MDF memiliki tingkat 

kepadatan yang lebih tinggi dibandingkan papan partikel, tetapi masih 

lebih rendah dibandingkan kayu solid. Struktur papan MDF memiliki 

tekstur yang konsisten dan halus, tanpa adanya serat kayu yang terlihat. 

MDF tidak mudah berubah bentuk akibat pengaruh suhu atau 

kelembapan, sehingga memiliki kestabilan dimensi yang baik . 

Papan MDF sangat mudah untuk dipotong, dibentuk, atau dipoles 

sesuai kebutuhan, MDF ini cukup stabil dan memiliki daya tahan yang 

baik serta memiliki permukaan yang licin dan halus, sehingga sangat 

cocok untuk pengecatan, pelapisan, atau penggunaan veneer dan kertas 

melamin. 

Papan MDF banyak dimanfaatkan untuk berbagai kebutuhan, seperti 

pembuatan furnitur, pintu, panel dinding, proyek konstruksi, dan desain 

interior. Dari segi biaya, papan MDF lebih ekonomis dibandingkan kayu 

solid memungkinkan pengrajin menghemat anggaran tanpa 

mengorbankan kualitas hasil akhir. Dipasaran papan MDF tersedia di 

berbagai ukuran dan sangat mudah untuk didapatkan. Keunggulan ini 

menjadikan papan MDF pilihan favorit pengrajin yang fokus pada detail 

dan efisiensi dalam proses pengukiran. 

Pengukiran pada papan MDF menggunakan mesin CNC laser 

memerlukan parameter permesinan yang tepat guna menghasilkan hasil 

yang optimal. Kombinasi parameter yang dimaksud meliputi feedrate 

dan daya laser. Kecepatan gerak laser atau feedrate berpengaruh 

terhadap kekasaran hasil. Sedangkan daya laser berpengaruh pada 

kemampuan pengukiran terhadap material. Penggunaan parameter yang 

tepat dapat memberikan hasil yang maksimal, akurat dan efisien [5][6].    

2. Metodologi 

Alat yang berfungsi untuk mewujudkan barang sesuai desain melalui 

pemrograman dengan komputer menggunakan bahasa G-code dan 

diproses dalam sebuah mesin pemotong, pengukir, pengeboran dan lain-

lain adalah mesin CNC. Mesin CNC memiliki keunggulan pada 

kepresisian dan keakuratan, penggunaan berbagai bahan material dasar, 

desain yang rumit dan waktu pengerjaan yang lebih efisien dibandingkan 

dengan proses secara manual [7]. 

Mesin CNC dikembangkan pada tahun 1952 oleh Jhon Pearseon dari 

Institut Teknologi Massachusetts yang awalnya diperuntukkan untuk 

membuat benda kerja khusus yang rumit. Mulai tahun 1975, produksi 

mesin CNC berkembang pesat dipacu oleh perkembangan 

mikroprosesor, sehingga volume unit menjadi lebih ringkas. Seiring 

dengan kemajuan teknologi di bidang komputer, maka dikembangkan 

sebuah software gambar Teknik dengan CAD, aplikasi tersebut dikenal 

dengan CAM (Computer Aided Manufacturing) [8][9]. Mesin CNC 

mengalami perkembangan menjadi mesin CNC Laser yang dapat 

mengukir bahkan memotong benda kerja. Prinsipnya hampir sama 

dengan mesin CNC pada umumnya, namun mesin CNC laser 

menggunakan cahaya laser untuk mengeksekusi benda kerja dan 

menggunakan komputer sebagai pengendali. Mesin CNC laser 

menggunakan motor stepper, pulley dan belt sebagai komponen 

pengerak yang terhubung dengan sistem kontrol melalui program 

perintah. 

Langkah-langkah perancangan keseluruhan ditunjukkan pada 

Diagram Alir umum diatas. Pertama Studi literatur dan observasi 

dilakukan untuk mendapatkan informasi dan sebagai referensi tentang 

pembuatan dan pengujian mesin CNC laser engraver. Selanjutnya 

melakukan analisa terhadap kebutuhan sistem elektrikal dan mekanikal. 

Perancangan sistem mekanikal dan elektrikal dilakukan untuk 

mengetahui komponen yang diperlukan agar dapat dilakukan pengadaan 

komponen untuk rancang bangun mesin CNC laser engraver. Setelah 

pengadaan komponen terpenuhi, perakitan mesin CNC laser dapat 

dilakukan. Proses instalasi program sistem kontrol meliputi penginputan 

firmware open source ke dalam mikrokontroler sebagai pusat kendali 

untuk menjalankan perintah dari aplikasi Laser GRBL dengan 
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menghubungkan Arduino Uno ke PC melalui USB [10]. Uji komponen 

dilakukan untuk mengetahui apakah seluruh komponen dapat menerima 

data dan beroperasi sesuai perintah. Pengkalibrasian dilakukan untuk 

mengoptimalkan hasil yang tepat presisi dengan optimasi seperti daya 

laser, feedrate serta jarak fokus laser terhadap benda kerja. Pengambilan 

data dapat dilakukan dari hasil pengujian yang dilakukan. 

 

 

 

 

 

 

 

 

 

   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 1. Diagram Alir umum Perancangan Mesin CNC Laser Engraver 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 2. Skematik Perancangan Sistem Kontrol [11] 

 

 

 

 

 
Gambar 3. Komponen Mekanikal Mesin CNC Laser Engraver 

Instalasi sistem kontrol merupakan tahapan menginstal atau 

menginput firmware GRBL ke dalam Arduino Uno. Pengunduhan dan 

penginstalan firmware GRBL harus dilakukan terlebih dahulu sebelum 

menggunakan CNC Shield dengan Arduino Uno. Berikut adalah tahapan 

yang dilakukan untuk menginstal GRBL pada Arduino. 

a. Langkah pertama adalah mengunduh firmware GRBL dengan 

mengunjungi halaman Github GRBL https://github.com/grb;/grbl. 

Klik tombol “Code” dan pilih “Download ZIP” untuk mengunduh 

firmware. 

b. Instal aplikasi Arduino IDE. 

c. Selanjutnya input GRBL ke Arduino IDE dengan langkah Sketch 

>Include Library > Add .Zip Library. Masukkan file ZIP GRBL ke 

perpustakaan Arduino. 

d. Lalu unggah firmware GRBL ke Arduino dengan langkah 

1. Sambungkan terlebih dahulu Arduino Uno ke PC melalui USB. 

2. Buka Arduino Ide lalu klik File > Examples > grbl > grblUpload. 

3. Pilh papan Arduino dan port yang sesuai dibawah Tools > Board 

dan Tools > Port. 

4. Klik tombol Upload untuk mengunggah firmware GRBL ke 

Arduino. 

e. Verifikasi Instalasi : 

1. Setelah melakukan pengunggahan, buka Serial Monitor dari 

Arduino IDE pada Tools > Serial Monitor. 

2. Atur baud rate ke 115200. 

3. Pop up "Grbl x.xj ['$' for help]" akan terlihat yang berarti GRBL 

sedang berjalan di Arduino. 

 

 

Gambar 4. GRBL Sedang Berjalan Di Arduino 

f. Hubungkan CNC Shield ke Arduino 

g. Uji pengaturan 
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1. Gunakan pengirim G-code yang kompatibel dengan GRBL untuk 

menguji pengaturan. Beberapa opsi adalah GRBL Panel, 

Universal Gcode Sender dan lain-lain. 

2. Muat file G-code sederhana dan kirim perintah untuk 

memastikan motor stepper merespon dengan benar. 

 

 

Gambar 5. Proses Menginput Firmware GRBL Kedalam Ardunio Uno 

Setelah tahapan perakitan komponen mekanikal dan elektrikal 

selesai, tahapan berikutnya adalah melakukan pengujian performa dan 

fungsi alat. Hal ini dilakukan agar memastikan bahwa seluruh komponen 

hardware maupun software bekerja sesuai dengan perancangan. Tujuan 

dari uji performasi adalah untuk mengetahui hasil dari perancangan. 

Pada pengujian fungsi, komponen hardware akan dioperasikan untuk 

mengetahui apakah motor stepper pada sumbu X dan Y dapat berotasi 

clockwise dan counter clockwise. Selanjutnya laser akan dioperasikan 

untuk mengetahui output laser sesuai dengan perancangan. 

Setelah fungsi hardware diuji, selanjutnya melakukan pengujian 

pada software. Pengujian pada software meliputi bagaimana Laser 

GRBL, motor stepper dan Arduino Uno berkomunikasi dengan data 

input analog. Arduino uno akan berkomunikasi dengan driver motor 

berupa sinyal. Sinyal ini akan diubah menjadi pulsa-pulsa yang 

memungkinkan motor stepper bergerak secara diskrit. Berikut adalah 

beberapa hasil dari Uji Fungsi sebagai berikut: 

a. Pengujian Garis Lurus 

 

 

 

 

 

 

 

 

 

 

 

 

b. Pengujian Persegi 

 

 

 

 

 

 

 

 

 

 

 

c. Pengujian Lingkaran 
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d. Pengujian Segi Lima 

 

 

 

 

 

 

 

 

 

 

 

 

3. Hasil dan Pembahasan 

Pengujian kinerja mesin dilakukan dengan parameter feed rate dan 

daya laser terhadap papan MDF tebal 6 mm dengan menggunakan data 

atribut. Dalam pengujian ini, Penulis menggunakan logo “POLITEKNIK 

NEGERI MEDAN” yang telah dikonversikan menjadi gambar vektor. 

Untuk mengetahui nilai dari parameter yang digunakan pada proses 

grafir, maka dilakukan beberapa pengujian. Tampilan hasil gambar 

Vektor " Politeknik Negeri Medan " pada Software LASER GRBL 

sebagai berikut: 

 

Gambar 6. Tampilan Vektor 
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Tabel 1. Pengujian Dengan Feedrate 250 mm/min 

No 

Feedr

ate 

(mm/

min) 

Daya 

laser (S-

max) 

Durasi 

(menit) 
Hasil Keterangan 

1 

250 

mm/

min 

25% 11.44 

 

Garis yang 

dihasilkan laser 

jelas, namun 

terlalu tebal 

pada gambar 

detail yg rumit 

2 

250 

mm/

min 

40% 11.44 

 

Garis yang 

dihasilkan 

tebal, untuk 

gambar yang 

detail tidak 

terlihat jelas 

3 

250 

mm/

min 

55% 11.44 

 

Garis yang 

dihasilkan 

sangat tebal 

sehingga 

kehilangan 

bagian gambar 

yang detail 

Tabel 2. Pengujian dengan Feedrate 500 mm/min 

No 

Feedr

ate 

(mm/

min) 

Daya 

laser 

(S-

max) 

Durasi 

(menit) 
Hasil Keterangan 

1 

500 

mm/

min 

25% 06.54 

 

Garis yang 

dihasilkan 

jelas namun 

tidak terlalu 

tebal 

2 

500 

mm/

min 

40% 06.54 

 

Garis yang 

dihasilkan 

laser sangat 

jelas 

3 

500 

mm/

min 

55% 06.54 

 

Garis yang 

dihasilkan 

terlihat 

cukup tebal 

 

 

 

 

 

 

Tabel 3. Pengujian dengan Feedrate 750 mm/min 

No 

Feedr

ate 

(mm/

min) 

Daya 

laser 

(S-

max) 

Durasi 

(menit) 
Hasil Keterangan 

1 

750 

mm/

min 

25% 04.42 

 

Garis yang 

dihasilkan 

tidak terlalu 

tebal 

2 

750 

mm/

min 

40% 04.42 

 

Garis yang 

dihasilkan jelas 

dan tebal 

3 

750 

mm/

min 

55% 04.42 

 

Garis yang 

dihasilkan laser 

terlalu tebal 

Tabel 4. Pengujian dengan Feedrate 1000 mm/min 

No 

Feedr

ate 

(mm/

min) 

Daya 

laser 

(S-

max) 

Durasi 

(menit) 
Hasil Keterangan 

1 

1000 

mm/

min 

25% 02.38 

 

Garis yang 

dihasilkan tipis 

sehingga ada 

bagian yang 

tidak terukir 

2 

1000 

mm/

min 

40% 02.38 

 

Garis yang 

dihasilkan 

cukup jelas dan 

tebal 

3 

1000 

mm/

min 

55% 02.38 

 

Garis yang 

dihasilkan 

sangat jelas 

dan tebal 

Berikut adalah analisis hasil pengujian pada mesin CNC laser 

engraver 

1. Hasil grafir menunjukkan pengaruh feedrate yang begitu besar pada 

kontras serta tebal atau tipis nya pada hasil akhir pengukiran. 

2. Kecepatan laju pergerakan laser mempengaruhi hasil gambar. Dapat 

disimpulkan bahwa semakin tinggi feedrate, maka akan semakin 

berkurang tingkat ketelitian kontras pada garis. Pada analisa hasil 

pengujian diatas menggunakan visualisasi, feedrate yang melebihi 

750 mm/min, maka garis yang dihasilkan dari hasil pembakaran sinar 

laser kurang jelas dan tidak kontras. Namun feedrate yang tinggi 

dapat dilaraskan dengan daya laser yang tinggi sehingga hasil 

pengukiran lebih jelas dan kontras. 
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3. Semakin tinggi feedrate, maka durasi waktu proses grafir juga 

semakin cepat. 

4. Daya laser mempengaruhi hasil gambar. Semakin tinggi daya laser 

yang digunakan, maka semakin tinggi tingkat kontras garis dari hasil 

pembakaran laser. Pada analisa hasil pengujian diatas, daya laser 

yang melebihi S-max 40% akan menyebabkan hasil yang gosong 

diakibatkan daya laser yang terlalu tinggi. 

5. Durasi proses grafir pada pengujian diatas beragam karena feedrate 

yang digunakan pada ketiga pengujian berbeda.  

4. Simpulan 

Berdasarkan hasil pengujian pengukiran menggunakan Mesin CNC 

Laser Mesin CNC Laser Engraver telah berhasil dirancang dan berjalan 

dengan baik. Pengujian kalibrasi mesin CNC Laser Engraver melibatkan 

beberapa langkah penting. Diantaranya, dengan memastikan komponen 

perangkat tepasang dengan benar, melakukan input pada kontroler 

Arduino Uno menggunakan bahasa pemrograman yang sesuai, lakukan 

kalibrasi yang meliputi kecepatan gerak laser dan posisi awal. Setelah 

program dan komponen dipastikan sesuai maka lakukan uji operasi pada 

mesin. Kinerja mesin dan kalibrasi yang telah dilakukan membuktikan 

bahwa mesin dapat berjalan dengan baik, sehingga dapat menghasilkan 

data yang berdasar pada hasil eksperiman. 

Dari hasil pengujian mesin CNC Laser Engraver, dapat disimpulkan 

bahwa material benda kerja dapat mempengaruhi kinerja mesin. Material 

yang lebih keras dan ketebalan yang lebih besar membutuhkan kecepatan 

pemotongan yang lebih lama dibandingkan dengan material yang bersifat 

lunak. Material yang menghasilkan kotoran atau debu dan serpihan dapat 

menyebabkan kerusakan pada komponen-komponen mesin. 

Berdasarkan pengujian grafir dengan metode feedrate dan daya laser 

dapat disimpulkan bahwa, pengaruh parameter pada hasil akhir dari kerja 

mesin CNC Laser Engraver sangat signifikan hasilnya terhadap hasil 

akhirnya. Pada hasil dari eksperimen yang dilakukan, daya sebesar 40% 

dan feedrate 500 mm/min menjadi standar parameter yang sesuai untuk 

pengerjaan pada media papan MDF dengan ketebalan 6 mm. 

Waktu pengoperasian mesin CNC Laser Engraver berpengaruh pada 

tingkat kesulitan dan ketilitian dari gambar yang akan digrafir. Dari hasil 

pengujian dapat disimpulkan bahwa, waktu yang dibutuhkan untuk 

mendapatkan hasil yang maksimal adalah 6 menit 54 detik. .  
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